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Initial Setup 
(A) Family Account Login 

1. Go to http://www.pottersschool.org/registered. 
2. Click the link labeled “Family page” to bring up a login screen. 

 

3. Enter your family e-mail address and password and click the “Login” button. If you don’t 
remember your password, or if you want to change your password, please send an e-mail with 
your preferred password to admin@pottersschool.org. 

 
  

http://www.pottersschool.org/registered
mailto:admin@pottersschool.org
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(B) Student Account Information 

NOTE: If you were a TPS student during the prior school year, your account information will be 
the same as it was during the previous school year.  

1. Locate the “Students” table on your family account page. Here you can see your students’ 
account information. (If you’re not sure how to access your family account page, see Topic A.) 

2. To see a student’s password, click the “Password” link next to that student’s information. 

 

Changing a student password 

NOTE:  You cannot change your studentȭÓ username. 

1. Follow steps 1-2 above. 
2. Click the “Edit” link. 

 

3. Replace the current password with the new one and click the “Update” button. The change is 
effective immediately. 

4. To return to the family account page, click the “Back to Students” link. 

Changing a student e-mail address 

1. From the “Students” table on your family account page, click the “Edit” link next to your 
student’s information. 

2. Replace the current e-mail address with the new one and click the “Update” button. 
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(C) Student Classroom Access Page Login 

1. Go to http://www.pottersschool.org/registered. 
2. Click the link labeled “Classroom access” to bring up a login screen. 

 

3. Enter your student’s username (ex. johns1) and password into the login fields. (If you don’t 
remember your student’s username and password, see Topic B.) 

4. Here you can see your student’s classes listed along with his/her seat statuses. If you have a 
question about your seat status or access, please send an e-mail to admin@pottersschool.org; 
however, if you have a question about your teacher placement, please send an e-mail to your 
instructor. 

NOTE: If you have trouble logging in, please see the troubleshooting section in Topic Z. 

 

5. To log in as a different student, click the “log off” link, then repeat step 3. You may be logged 
out automatically if you close your browser.  

 

http://www.pottersschool.org/registered
mailto:admin@pottersschool.org
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(D) Validating Your GP5 Account (Primary Automatic Method) 

1. Download the latest version of GP5 at http://www.pottersschool.org/support/#downloading 
and install it. 

2. Log in to the student classroom access page (If you don’t remember how to log in to the student 
classroom access page, see Topic C). 

3. Click the “Validate GP5 and take me to my classrooms” link to automatically open and configure 
your GP5 software with your student’s account. 

 

4. Your Internet browser may ask you to allow GP5 to open the link. Instructions on how to do this 
for your Internet browser will open in a new window. 

NOTE: These instructions will continue to appear even when you have set your Internet 
ÂÒÏ×ÓÅÒ ÔÏ ÒÅÍÅÍÂÅÒ ÔÏ ÏÐÅÎ ȰÏÍÎÉÖÉÅ×ȱ ÌÉÎËÓ ÉÎ '0υȢ 4ÈÉÓ ÉÓ ÎÏÒÍÁÌ ÁÎÄ ÄÏÅÓ ÎÏÔ ÉÎÄÉÃÁÔÅ Á 
problem with your GP5 installation. 

5. Please be patient while GP5 is configured. Depending on your connection, it can take from a few 
seconds to a minute to validate your account. 

Validating a different student account 

1. Log out of the student classroom access page and log back in as the new student. 
2. Follow steps 3-5. 

NOTE:  Multiple accounts cannot be validated on the same computer at the same time. For 
multiple students using the same computer, you must validate the new account each time a 
different student attends class. However, GP5 maintains validation for the last account that 
used it, so if you are the only student taking TPS classes on your computer, you will not need to 
revalidate before class. 

 

http://www.pottersschool.org/support/#downloading
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(E) Validating Your GP5 Account (Alternate Manual Method) 

NOTE: This is an alternate method to the automatic method described above.  You must do one 
ÏÒ ÔÈÅ ÏÔÈÅÒ ÔÏ ÖÁÌÉÄÁÔÅ ÙÏÕÒ ÓÔÕÄÅÎÔȭÓ ÁÃÃÏÕÎÔȟ ÂÕÔ ÙÏÕ ÄÏ ÎÏÔ ÎÅÅÄ ÔÏ ÄÏ ÂÏÔÈȢ 

1. Download the latest version of GP5 at http://www.pottersschool.org/support/#downloading 
and install it.  

2. Open the GP5 application. (If you just installed GP5, it will open on its own.) 
3. The “Account Setup” screen will display if you have not yet validated your account. 
4. Enter your student’s username and password into the appropriate fields. (If you don’t 

remember your student’s username and password, see Topic B.) 
5. Click “Validate Account.” 

  

6. Please be patient while GP5 is configured. Depending on your connection, it can take from a few 
seconds to a minute to validate your account. Once your account is validated, the “Account 
Setup” screen will close automatically. 

Validating a different student account 

1. Click the icon shaped like a head with a pencil ( ) to open the “Account Setup” screen. 
2. Click the “Clear Account” button to clear the previous account’s information. 
3. Follow steps 4-7 above. 

NOTE:  Multiple accounts cannot be validated on the same computer at the same time. For 
multiple students using the same computer, you must validate the new account each time a 
different student attends class. However, GP5 maintains validation for the last account that 
used it, so if you are the only student taking TPS classes on your computer, you will not need to 
revalidate before class. 

 

http://www.pottersschool.org/support/#downloading
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(F) Setting Up Audio Devices in GP5 

The Audio Tuning Wizard will help you get your audio devices (microphone and headphones or 

speakers) set up correctly. The wizard’s icon ( ) is located in the toolbar at the bottom-right 
corner of GP5 and is available any time you are not in a GP5 room. If you do need to manually check 
or adjust the settings for your audio devices, follow the directions below. 

NOTE: TPS recommends using a wired USB headset with a directional microphone for GP5 
classes. We strongly discourage the use of integrated (built-in) microphones, earpieces, and 
wireless headsets due to the poor audio quality these devices can provide. 

1. Open the GP5 application. 

2. Click the icon shaped like two gears ( ) to open the “Preferences” window. 

3. Click the “Audio Setup” tab. The icon in the top-left corner should show a headset ( ). If it 

shows a speakerphone ( ) instead, click it to change it to a headset. 
4. Choose your external microphone from the “Recording / Microphone” dropdown menu. (If you 

are using a USB headset, choose it instead.) 
5. Choose your external speakers or sound card from the “Playback / Headphones” dropdown 

menu. (If you are using a USB headset, choose it instead.) 
6. Click the “OK” button on the preferences window to save your changes. 

 

7. To run the Audio Tuning Wizard, click its icon ( ) in the toolbar at the bottom-right corner of 
GP5. 

NOTE:  When using an external microphone and speakers, students must mute their speakers 
while they are speaking on the microphone to avoid creating an echo. 
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(G) Adjusting Your Microphone Level 

If you are getting reports from your teacher or other students that you are difficult to understand 
over the microphone, you probably need to adjust your microphone level. Reports that you are 
scratchy or have a lot of background noise mean you should turn your microphone down, while 
reports that you are faint or quiet mean you should turn your microphone up. 

Adjusting your microphone level in Windows XP. 
1. Right-click the speaker icon in your system tray and choose “Adjust Audio Properties.” 

 

2. In the Voice tab, choose the microphone that you are using in GP5 from the Voice Recording 
dropdown menu. Click the Volume button. 

 

3. Adjust the Volume slider as needed. A good place to start is at 25 percent; you can fine tune 
your level from there as you need to. 
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(G) Adjusting Your Microphone Level (continued) 

Adjusting your microphone level in Windows Vista or 7. 
1. Right-click the speaker icon in your system tray and choose “Recording options.” 

 

2. Click the microphone that you are using in GP5 from the list, and then click the Properties 
button. 

 

3. Open the levels tab and adjust the Microphone slider as needed. A good place to start is at 25 
percent; you can fine tune your level from there as you need to. 
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(G) Adjusting Your Microphone Level (continued) 

Adjusting your microphone level on a Mac. 
1. From the Apple menu, choose “System Preferences.” 

 

2. Choose “Sound.” 

 

3. In the Input tab, choose the microphone that you are using in GP5 from the list, and then adjust 
the Input volume slider. A good place to start is at 25 percent; you can fine tune your level from 
there as you need to. 
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(H) StudyPlace Login 

Logging in under a parent account 

1. Go to http://tps.studyplace.us 
2. Enter your family e-mail address and password and click the “Login” button. If you don’t 

remember your password, or if you want to change your password, please send an e-mail with 
your preferred password to admin@pottersschool.org. 

Logging in under a student account 

1. Go to http://tps.studyplace.us 
2. Enter your student’s username (ex. johns1) and student’s password and click the “Login” button. 

(If you don’t remember your student’s username and password, see Topic B.) 

Logging out or switching  users 

1. While logged in to StudyPlace, look at the upper right corner (right above the calendar) to see 
what account you are currently using. 

2. To log out, click the “Logout” link to the right of your account name. 
3. You will be returned to the login page. If you want to switch to a different user, enter that user’s 

username and password and click the “Login” button. 

 

http://tps.studyplace.us/
mailto:admin@pottersschool.org
http://tps.studyplace.us/
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Going to Class 
(I) A Tour of GP5 

The full view: 

 

1. The top bar: 

 

2. View options: 

 

Turning scaling on will shrink your view of your teacher’s screen to fit completely within the GP5 
window. You can use the screenshot button to take pictures of your teacher’s presentation area. 
The pictures are saved to My Documents\gp5 in Windows. 
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(I) A Tour of GP5 (continued) 

3. Room controls 

 

Shrinking GP5 to mini-mode will reduce GP5 to a small toolbar. This is used when presenting 
your screen to keep GP5 from taking up too much room on your screen. 

4. Widget controls 

 

Undocking the chatbox creates a new, resizable window for the chatbox. The same can be done 
to the participation list. You can only private chat with your teacher. 

5. Toolbar 

 

The Audio Tuning Wizard is only available when not in a GP5 room. 
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(J) Attending Class 

NOTE: All class times on our website are listed in Eastern Time with daylight-saving time 
observed. 

1. Open the GP5 application. Your student’s account must be validated to continue. (If you don’t 
remember how to validate your student’s account, see Topic D.) 

2. If the room list is not already open, click the “Rooms” button in the top-left corner of GP5 to 
open it. 

3. In the room list, click on the class you wish to attend, then click the Join button in the top-right 
corner of the screen. Classrooms are only accessible from five minutes before class begins until 
five minutes after class ends. 
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(K) Accessing Other GP5 Rooms 

Accessing the Student Center and study rooms  

1. Open the GP5 application. Your student’s account must be validated to continue. (If you don’t 
remember how to validate your student’s account, see Topic D.) 

2. If the room list is not already open, click the “Rooms” button in the top-left corner of GP5 to 
open it. 

3. In the room list, click on the room you wish to access, then click the Join button in the top-right 
corner of the screen. 

 

Accessing rooms not in the room list 

1. Click the icon shaped like a head with a pencil ( ) to open the “Account Setup” screen. 
2. In the “Access Code” field, enter the seven-digit number for the room you want to access. 
3. Click “Join Session.” 

 

NOTE: 4Ï ÁÃÃÅÓÓ ÙÏÕÒ ÉÎÓÔÒÕÃÔÏÒȭÓ ÔÕÔÏÒÉÎÇ ÒÏÏÍȟ ÙÏÕ ÍÕÓÔ ÅÉÔÈÅÒ obtain the seven-digit 
number for the room from your instructor or click the tutoring room link in your StudyPlace 
course page (see Topic O). 4ÕÔÏÒÉÎÇ ÒÏÏÍÓ ÓÈÏÕÌÄ ÏÎÌÙ ÂÅ ÁÃÃÅÓÓÅÄ ×ÉÔÈ ÙÏÕÒ ÉÎÓÔÒÕÃÔÏÒȭÓ 
permission. 
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(L) Viewing a GP5 Recording 

1. Open the GP5 application. Your student’s account must be validated to continue. (If you don’t 
remember how to validate your student’s account, see Topic D.) 

2. Open the room list by clicking the “Rooms” button. 
3. Choose the class for the recording that you are looking for. 
4. Open the “Recordings” tab. 

 

5. Click on the recording you want to watch, and then click the “Play” button. 

 

6. GP5 will open the recording; it will look like a classroom in which you are the only participant. 
The recording will begin automatically but, depending on your connection speed, it may take 
from a few seconds to a minute to load. 

7. The following controls will be at the bottom of the playback window:  

 

The recording position slider can be dragged to move around in a recording more quickly than 
the skip buttons allow. 

Dialing in to recordings 

1. Click the icon shaped like a head with a pencil ( ) to open the “Account Setup” screen. 
2. In the “Access Code” field, enter the eight-digit number for the recording you want to access. 
3. Click “Join Session.” 
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(M) Accessing GP5 Rooms as a Parent 

NOTE: This process may not be used to access classrooms. Please see Topic M for information 
on observing classes as a parent. 

1. Open the GP5 application. 
2. Follow steps 1-6 in Topic E to manually validate your GP5 software using your family e-mail 

address and password. (If you don’t remember your password, or if you want to change your 
password, please send an e-mail with your preferred password to admin@pottersschool.org.) 

3. Refer to Topic I for instructions on accessing non-classrooms. These methods work the same for 
family accounts as they do for student accounts. 

NOTE: Multiple accounts cannot be validated on the same computer at the same time, so your 
student will need to ensure that his or her account is validated before attending class again. 

 

(N) Observing Class as a Parent 

We very much encourage parents to observe their students’ classes whenever possible.  However, if 
we allowed parents to sign in to classes on a separate computer from their student, each classroom 
would have to support twice as many participants; this would mean twice the bandwidth costs for 
us and therefore much higher tuition for you!  Instead, we encourage you to listen in using one of 
the two methods below. 

NOTE: 9ÏÕÒ ÓÔÕÄÅÎÔȭÓ ÁÃÃÏÕÎÔ ÍÕÓÔ ÂÅ ÖÁÌÉÄÁÔÅÄ ÔÏ ÁÔÔÅÎÄ ÃÌÁÓÓȟ ÅÖÅÎ ×ÈÅÎ ÐÁÒÅÎÔÓ ÁÒÅ 
observing. Family accounts cannot be used to access GP5 classrooms.  

Primary Method : Configuring your GP5 audio output through external speakers 

1. Open the GP5 application. 

2. Click the icon shaped like two gears ( ) to open the “Preferences” window. 

3. Click the “Audio Setup” tab. The icon in the top-left corner should show a headset ( ). If it 

shows a speakerphone ( ) instead, click it to change it to a headset. 
4. Choose your USB headset from the “Recording / Microphone” dropdown menu. 
5. Choose your external speakers or sound card from the “Playback / Headphones” dropdown 

menu. 
6. Click the “OK” button on the preferences window to save your changes. 

 

NOTE:  When using this audio configuration, students must mute their speakers while they are 
speaking on the microphone to avoid creating an echo. 

 

mailto:admin@pottersschool.org
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(N) Observing Class as a Parent (continued) 

Alternate Method: Toggling between speakers and headset for GP5 audio output 

1. Follow steps 1-3 above  
2. Choose your USB headset from the “Recording / Microphone” dropdown menu. 
3. Choose your USB headset from the “Playback / Headphones” dropdown menu. 

4. Click the headset icon ( ) to change it to a speakerphone ( ). 
5. Choose your external microphone from the “Recording / Microphone” dropdown menu 
6. Choose your external speakers or sound card from the “Playback / Headphones” dropdown 

menu. 
7. Click the “OK” button on the preferences window to save your changes. 
8. Once you complete these steps, you will be able to see a new headset icon next to the 

preferences account setup icons. Click this icon to toggle between the two options: 
 

  

Headset selected Speakerphone selected 

9. When the headset icon is selected, GP5 will send audio to and receive audio from your headset. 
When the speakerphone icon is selected, GP5 will send audio to your external speakers and 
receive audio from your external microphone.  

NOTE:  7ÈÅÎ ÕÓÉÎÇ ÔÈÅ ȰÓÐÅÁËÅÒÐÈÏÎÅȱ ÁÕÄÉÏ ÃÏÎÆÉÇÕÒÁÔÉÏÎȟ ÓÔÕÄÅÎÔÓ ÍÕÓÔ ÍÕÔÅ ÔÈÅÉÒ ÓÐÅÁËÅÒÓ 
while they are speaking on the microphone to avoid an echo. 
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StudyPlace Basics 
(O) Viewing a Course in StudyPlace 

1. Log in to StudyPlace using a student or family account (see Topic H). That first page that opens is 
called the “StudyPlace Commons.” 

2. On the lower left side of the page, locate “My courses” (you may need to scroll down the page 
to see it). Click on the course you want to view. This will take you to the course page for that 
course. 

 

See the next topic for a tour of a StudyPlace course. 
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(P) A Tour of a StudyPlace Course 

The full view: 

 

The left side: 
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(P) A Tour of a StudyPlace Course (continued) 

The right side: 
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(Q) Submitting an Assignment in StudyPlace 

NOTE: You can only submit assignments when logged in as a student. 

1. Using your student account, open the course page for the course with the assignment you want 
to view. (If you don’t remember how to open course pages, see Topic N.) 

2. Click on the assignment you wish to submit. All assignments are marked with the same “hand 
returning paper” icon, as below:  

 

3. The page that opens will give a brief description of the assignment as well as the assignment’s 
due date and a place to submit your completed work. 

 

4. Click “Browse” and find the file on your computer that you want to submit. Once a file is 
selected, its name will appear to the left of the “Browse” button.  Click “Upload this file” to 
submit the file for that assignment. 

 

5. Please be patient while your file uploads. Depending on the speed of your connection and the 
size of the file, uploading may take from several seconds to a minute. 

6.  When the file has been successfully submitted, you will see it listed on the assignment page.   
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(R) Tips for Reducing File Size 

With very few exceptions (almost none), students may only upload files of size 2 MB or smaller. 
Occasionally this can be a difficult size to maintain with files containing images (such as PowerPoint 
presentations), but following the tips below can help you keep your file size small enough. 

Windows users with Microsoft Word or PowerPoint 2007/2010: 

1. Once you’ve added all of your images to the file, click one of them. This will cause the Format 
tab to appear at the top of the window. 

 

2. Open the Format tab and click the “Compress Pictures” option on the left end of the menu. 

 

3. Now save your file. You can check its size by holding your cursor over its icon in the file browser. 

 

4. If your file is still too large, try decreasing the image’s dimensions within the file, then 
compressing and saving again. 
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(R) Tips for Reducing File Size (continued) 

Windows users uploading images directly: 

When uploading images directly to StudyPlace, don’t use TIFF images (.tif files) unless your teacher 
requests them. These files are always extremely large. Better formats to use are PNG and JPEG. 

Sometimes images have too large of a file size simply because the image itself is too large. You can 
easily reduce the size of your image using these steps. 

1. Open your image in Paint and click the Resize button. 

 

2. Make sure that “Maintain aspect ratio” is checked and “Percentage” is selected, then reduce 
one of the values to reduce the size of the image. Reducing the image to 75% should cut the file 
size to a little more than half of its original size, and reducing the image to 50% should cut the 
file size to about a fourth of its original size. 

 

3. Click okay and save your image. You can check its size by holding your cursor over its icon in the 
file browser. 
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(R) Tips for Reducing File Size (continued) 

Mac users 

Mac versions of Microsoft Word and PowerPoint do not have the option to compress images, so you 
will need to compress each image in Preview before adding it to a document or presentation. You 
can also use this method for images that you are planning to upload directly. 

1. Open your image in Preview, go to the File menu, and choose Save As. 

 

2. Make sure that the Format dropdown is set to "JPEG." This will enable the Quality slider, which 
you can use to change the compression of the image. Moving the slider towards “Least” will 
reduce the size of the image file, which will be reflected in the “File Size” indicator. 
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StudyPlace Basics for Parents 
(S) Unsubscribe from Student Forums (For Parents) 

NOTE:  You will not be able to unsubscribe from the News forum. This forum is used by the 
course instructor to send important course announcements and reminders, and all families and 
students are subscribed to this forum so that they do not miss any important information. 

1. Using your family account, open the course page with the forum from which you want to 
unsubscribe. (If you don’t remember how to open course pages, see Topic N.)  

2. On the upper left side of the page, locate “Activities.” Click the “Forums” link.  

 

3. From the list of forums that opens, click “Yes” for all forums from which you want to 
unsubscribe.  This will change the indicator button to “No” and will unsubscribe you from those 
forums. 
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(T) 6ÉÅ×ÉÎÇ 9ÏÕÒ 3ÔÕÄÅÎÔȭÓ 'ÒÁÄÅÓ 

1. Log in to StudyPlace using your family account. (If you don’t remember how to log in to 
StudyPlace, see Topic H.) 

2. On the upper right side of the StudyPlace Commons, click the student whose grades you want to 
view. 

 

3. Click the name of the course you want to view. 

 

4. Click the “Activity Reports” tab. 
5. Click the “Grade” sub-tab to display your student’s grades for the chosen course. 

 

6. To view the grades for a different course, click your student’s name in the “bread crumbs” at the 
top of your screen and follow steps 3-5 for the new course. To return to the StudyPlace 
Commons and select a different student, click “TPS StudyPlace.” 
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Troubleshooting 
(Z) GP5 Audio Troubleshooting 

If you are having trouble hearing audio in class, try the following possible fixes. If you are getting 
reports that you are hard to hear or understand over your microphone, or if you cannot hear your 
voice coming back to you in the third part of the Audio Tuning Wizard, see Topic G. 

1. Ensure you have the correct audio devices selected in GP5. 
If you cannot hear audio in class at all, see Topic F for instructions on using the Audio Tuning 
Wizard and manually adjusting audio device settings in GP5. Having the correct audio devices 
selected in GP5 will ensure that you pass the first part of the Audio Tuning Wizard, so if you 
cannot hear audio in the first test, you will need to go back and be sure that you have the right 
devices selected.  

2. Toggle the SIP TCP Signaling setting. 
If you cannot hear audio in class or the second test of the Audio Tuning Wizard, try changing this 
setting. In the GP5 Tools menu, click the “SIP TCP Signaling” option. If changing this setting does 
not fix the problem, make sure you change it back by clicking it again, and then e-mail 
tech@pottersschool.org for further assistance. 

 

3. Change the GP5 Internet Speed setting. 
If you can hear audio in class, but it is garbled or crackly, try changing GP5’s Internet speed 
setting. This is an especially common problem with satellite Internet users. Open the GP5 

Preferences window by clicking its icon ( ), and go to the Network Settings tab. Find the 
Internet Speed dropdown menu and choose “Low Speed DSL/Cable Modem,” then test your 
audio in the Audio Tuning Wizard. If it is still choppy, try “56K Dialup Modem.” Note that this 
setting does not reflect your actual Internet connection or modem. 

 

4. Wireless router issues. 
If you are using a wireless router, and you get a “machine sound” in your audio, your network is 
losing information. You should first try rebooting your router; if that does not help, try moving 
closer to the router or connecting directly to the router with an Ethernet cable in case your Wi-
Fi signal is not strong enough. 

 

mailto:tech@pottersschool.org

